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INTRODUCTION

The EX700i Print Server/Integrated Fiery Color Server media pack includes a set of software 
utilities that allow you to manage the EX700i Print Server/Integrated Fiery Color Server, as 
well as the print workflow and content of jobs on the EX700i Print Server/Integrated Fiery 
Color Server.

This document provides an overview of how to install, configure, and use the following 
EX700i Print Server/Integrated Fiery Color Server utilities:

• Command WorkStation monitors and manages the print workflow of jobs on the EX700i 
Print Server/Integrated Fiery Color Server.

• Fiery SeeQuence Suite integrates document preparation activities at both the sheet level 
and page level in one visual interface.

– Fiery SeeQuence Preview provides a preRIP soft proof of each sheet surface of a job. 
Changes dynamically to display any changes made in preparing documents for 
printing.

– Fiery SeeQuence Impose applies imposition layouts to jobs for custom printing, 
binding, and cutting.

– Fiery SeeQuence Compose defines the chapter divisions of a job, printing ranges of 
pages on varying types of media, inserting blank media between pages, and tab media 
containing text labels. 

• Paper Catalog defines and stores the attributes of printing media in a system-based paper 
warehouse database. 

• Productivity Package offers additional color and production features for Integrated Fiery 
Color Server operators (or users with Operator or Administrator privileges) to monitor 
and manage the print workflow of jobs on the Integrated Fiery Color Server. 

• Remote Scan retrieves a scan on the digital press from a remote computer on the network. 
Includes the Scan TWAIN plug-in module. 

• Fiery Bridge accesses scanned documents in your EX700i Print Server/Integrated Fiery 
Color Server mailbox directly from a client Windows computer.

• Hot Folders provide a simple and automated method of sending print jobs to the EX700i 
Print Server/Integrated Fiery Color Server across the network by allowing documents to be 
dropped into a folder associated with preset print options.

• WebTools manages your EX700i Print Server/Integrated Fiery Color Server remotely from 
the Internet or your company’s intranet.

For information about using color management, see Color Printing. 



INTRODUCTION 8

Terminology and conventions
This document uses the following terminology and conventions.  

About Help

Detailed instructions on using most EX700i utilities are provided in the online Help. 
Wherever appropriate, this document refers you to Help for additional information and 
explains how to access Help for each utility. 

Term or convention Refers to

Aero EX700i (in illustrations and examples)

Digital press Xerox 700 Digital Color Press

EX700i EX700i Print Server/Integrated Fiery Color Server

Mac OS Apple Mac OS X

Titles in italics Other documents in this set

Windows Microsoft Windows XP, Windows Vista, Windows Server 
2003/2008/2008 R2, Windows 7

Topics for which additional information is available by starting 
Help in the software

Tips and information

A warning concerning operations that may lead to death or injury 
to persons if not performed correctly. To use the equipment safely, 
always pay attention to these warnings.

 A caution concerning operations that may lead to injury to persons 
if not performed correctly. To use the equipment safely, always pay 
attention to these cautions.

Operational requirements and restrictions. Be sure to read these 
items carefully to operate the equipment correctly, and avoid 
damage to the equipment or property.
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INSTALLING USER SOFTWARE

This chapter describes installation of EX700i user software on Windows and Mac OS 
computers. 

You can install EX700i user software in the following ways:

• From the User Software DVD

• From the EX700i, using the Internet or intranet

• From the EX700i directly, over the network (for the EX700i Print Server only)

If you previously installed any EX700i user software on your computer, the Installer allows 
you to uninstall those applications during the process.

Preparing for installation on a Windows computer
Before installing EX700i software on a Windows computer, be sure to complete the 
following:

• To use EX700i user software on a Windows computer, the Sun Java file, Java Runtime 
Environment (JRE), provided in the Common Utilities folder on the User Software DVD, 
must be installed on your computer. If the correct Sun Java file is not installed, the Fiery 
User Software Installer installs it automatically before installing the EX700i software. 

NOTE: The recommended version of Sun Java JRE is provided on the User Software DVD.

After installation of Sun Java JRE, a Java Web Start shortcut is created on your computer 
desktop. The shortcut is not intended for use with EX700i software and can be deleted.

Different versions of Sun Java JRE can be installed on your computer. The EX700i software 
automatically finds the correct version, so you do not need to uninstall other versions of Sun 
Java JRE required for third-party applications.

To install the EX700i software, make sure that your computer meets the minimum system 
requirements. If the latest service pack is not installed, a warning message alerts you to install 
it.

For information about system requirements, see Welcome.
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Installing user software on a Windows computer
All installation of user software on a Windows computer is done through the Fiery User 
Software Installer. The following procedures describe installing from the User Software 
DVD, over the network, or over the Internet, and also modifying the user software. 

The only applications that are not installed by the Fiery User Software Installer are Adobe 
Acrobat and Enfocus PitStop, for use with Fiery SeeQuence Suite. For more information, see 
“Installing and enabling SeeQuence Suite” on page 31.

TO INSTALL USER SOFTWARE ON A WINDOWS COMPUTER FROM THE USER SOFTWARE DVD

1 Insert the User Software DVD into the DVD drive of the computer.

The Installer Welcome screen appears.

2 Follow the on-screen instructions.

Do not attempt to install user software by opening the individual folders for the applications. 
To modify or remove user software after you install it on your computer, use the User 
Software DVD and the following procedure.
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TO MODIFY USER SOFTWARE USING THE USER SOFTWARE DVD INSTALLER

1 Insert the User Software DVD into the DVD drive of your computer.

2 On the window that appears, select Add/Remove, Repair, or Remove.

3 Follow the on-screen instructions.

If your computer does not have a DVD drive, you can install the user software from the 
EX700i over the network. Ask your network administrator for the IP address or DNS server 
name of the EX700i.

You can also install the user software from the EX700i over the Internet or your company’s 
intranet. Ask your network administrator for the IP address of the EX700i.

Use your Internet browser to access WebTools. For complete information about browser and 
system requirements, see Welcome.

TO INSTALL USER SOFTWARE ON A WINDOWS COMPUTER OVER THE NETWORK 

1 Click Start, choose Run, and type the IP address or DNS server name of the EX700i.

2 Type the user name and password, if required.

Ask your network administrator if a password is required.

3 Double-click the PC_User_SW directory.

4 Double-click the Master Installer icon.

5 Follow the on-screen instructions.

TO INSTALL USER SOFTWARE ON A WINDOWS COMPUTER OVER THE INTERNET USING WEBTOOLS

1 Start your Internet browser. 

2 Type the IP address or DNS name of the EX700i.

The EX700i home page appears. 

3 Click the Downloads tab.

4 Click the link for the software that you want to install.

5 Choose Run to open the file or choose Save to save it to your computer.

6 If you choose Run, proceed to step 9.

7 If you choose Save, browse to the location where you want to save the USERSWMI.exe file, 
and then click Save.

The file is downloaded from the EX700i.

8 Double-click the USERSWMI.exe file.

9 Type the EX700i URL, http://<IP address>, when prompted. 

10 Follow the on-screen instructions.
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For complete instructions on how to use Downloads, see Help. 

For more information about WebTools and Downloads, see page 52.

Do not attempt to install user software by opening the individual folders for the applications. 
Always use the Fiery User Software Installer.

Uninstalling user software on a Windows computer

To remove user software after you have installed it on your Windows computer, use the Fiery 
User Software Installer. See “To modify user software using the User Software DVD Installer” 
on page 11.

Installing user software on a Mac OS computer
Installation of user software on a Mac OS computer is done separately for each application. 
If necessary, you can uninstall the user software using the Fiery Software Uninstaller. The 
following procedures describe installing and uninstalling user software. 

For information about installing printer drivers, see Printing.

TO INSTALL USER SOFTWARE ON A MAC OS COMPUTER FROM THE USER SOFTWARE DVD

1 Insert the User Software DVD into the DVD drive of your computer.

2 Browse to the OSX folder.

3 Double-click the Installer icon for the application that you want to install.

4 Follow the on-screen instructions.

You can also install the user software from the EX700i over the Internet or your company’s 
intranet. Ask your network administrator for the IP address of the EX700i.

Use your Internet browser to access WebTools. For complete information about browser and 
system requirements, see Welcome.

TO INSTALL USER SOFTWARE ON A MAC OS COMPUTER OVER THE NETWORK 

1 Choose Connect to Server from the Go menu.

2 Type smb:// followed by the IP address of the EX700i, and then click Connect.

If you cannot locate the EX700i, contact your network administrator.

3 Type the user name and password, if required.

Ask your network administrator if a password is required.

4 Select the smb shared volume that you want to connect to. 
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5 Select Mac_User_SW and click OK.

6 Open the OSX folder.

7 Double-click the installer icon for the application that you want to install.

8 Follow the on-screen instructions.

TO INSTALL USER SOFTWARE ON A MAC OS COMPUTER OVER THE INTERNET USING WEBTOOLS

1 Start your Internet browser. 

2 Type the IP address or DNS name of the EX700i.

The EX700i home page appears. 

3 Click the Downloads tab.

4 Click the link for the software that you want to install.

The osxutils.dmg file is downloaded to your computer. and a virtual disk appears on your 
desktop.

5 Follow the on-screen instructions.

For complete instructions on how to use Downloads, see Help. 

For more information about WebTools and Downloads, see page 52.

Uninstalling user software on a Mac OS computer

To remove user software after you have installed it on your Mac OS computer, use the Fiery 
Software Uninstaller utility and the following procedure.

TO UNINSTALL USER SOFTWARE ON A MAC OS COMPUTER

1 Insert the User Software DVD into the DVD drive of your computer.

2 Browse to the OSX folder.

3 Click the icon for the Fiery Software Uninstaller.

4 Select the software you want to uninstall and follow the on-screen instructions.
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COMMAND WORKSTATION

Command WorkStation enhances the user experience and improves productivity. The 
cross-platform application gives operators the tools to manage jobs on the EX700i, and 
administrators the tools to configure the EX700i for printing. Command WorkStation 
includes the Job Center for job management, Device Center for server resource 
management, and Fiery SeeQuence Suite for preparing jobs for printing.

In the Job Center and Device Center views, the Server List shows all of the EX700i servers 
that you are connected to. You can switch between servers, and add or remove them from the 
list. Information about consumables on the digital press, tray association status, and errors 
and alerts is available. 

• Job Center displays the tools for managing jobs in the print queues, and a job preview of 
processed jobs. The status of jobs is shown. You can search for jobs and access features 
from the customizable toolbar.

• Device Center gives you access to all of the resources of the EX700i. From the Device 
Center, you can access Setup and tools such as calibration and Back up and Restore. You 
can perform Color Setup, configure Virtual Printers, and create Paper Catalog entries.
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Command WorkStation utilities
Command WorkStation provides access to the following utilities:

• Backup and Restore

• Booklet Maker

• Calibrator

• Color Management

• Configure

• Fiery JDF

• Job Properties

• Paper Catalog

• Quick Doc Merge

• Tray Alignment

• Tray Association

• VDP Resources

• Fiery SeeQuence Impose

• Fiery SeeQuence Compose (if supported)
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Installing Command WorkStation
Install Command WorkStation on a Windows or Mac OS computer with a network 
connection to the EX700i. For a complete list of system requirements, see Welcome.

The Command WorkStation Installer is provided on the User Software DVD as part of the 
Fiery User Software Installer (Windows computers) or as a separate application (Mac OS X). 
To install Command WorkStation, see “Installing User Software” on page 9.

Configuring the connection to the EX700i 

The first time you start Command WorkStation, you are prompted to configure the 
connection to the EX700i. You can also edit the configuration whenever there is any change 
to your EX700i or network, such as a changed server name or IP address. If you change 
EX700i Setup information, do so before you reconfigure the connection. 

BEFORE YOU BEGIN

• Print the EX700i Configuration page.

For instructions on printing the Configuration page, see Configuration and Setup, which is 
part of the user documentation set.

The EX700i Configuration page contains information you need when configuring the 
connection, such as the IP address of the EX700i. For TCP/IP installations, you can use the 
DNS name instead of the IP address. Make sure that the EX700i is registered in a Domain 
Name Server (DNS) on your network. For more information, contact your network 
administrator.

TO CONFIGURE THE CONNECTION FOR COMMAND WORKSTATION

1 Start Command WorkStation:

Windows: Programs > Fiery > Fiery Command WorkStation 5

Mac OS: Applications : Fiery : Command WorkStation 5 : Command WorkStation

2 Type the DNS name or IP address and click Add to add the server to the Disconnected Servers 
list.

If no EX700i is found, click the  icon, search by a range of IP addresses or by the IP 
address and subnet mask, and then click Go. Or, select Auto Search.



COMMAND WORKSTATION 17

All available servers are listed.

To search for a particular server, type the server name in the Filter by keyword field.

Select the EX700i that you want to use, click Add, and then click Connect.

The Login dialog box appears.

3 Select Administrator, Operator, or Guest and type the appropriate password, if required.

Ask your administrator for the password for the EX700i that you want to connect to.

For information about setting passwords and the default Administrator password for the 
EX700i, see Configuration and Setup, which is part of the user documentation set.

4 Click Log In.

Command WorkStation is now connected to the EX700i.

For information about managing and connecting additional EX700i servers, see Command 
WorkStation Help.
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Using Command WorkStation
After you install and configure Command WorkStation, you can begin using it to monitor 
and manage jobs on the EX700i. 

About Help

For instructions on using Command WorkStation features, see Command WorkStation Help. 
The Help menu offers access to the following kinds of Help:

• Online Help provides procedural information.

• How To accesses the EFI web page, which provides demo scripts and sample files.

• What’s New describes the new features of Command WorkStation.

TO ACCESS COMMAND WORKSTATION HELP

1 Start Command WorkStation.

Select the EX700i from the Server list and log on to the server.

For information about setting passwords and the default Administrator password for the 
EX700i, see Configuration and Setup. 

2 Choose Help, How To, or What’s New from the Help menu.
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Additional features
The following sections describe how to use additional features of Command WorkStation that 
are not discussed in Command WorkStation Help.

Mixed Media

The Mixed Media feature allows you to define the chapter divisions of a job, print ranges of 
pages on varying types of media, insert blank media between pages, and insert tab media 
containing text labels.

The following guidelines and restrictions apply to Mixed Media settings:

• The Mixed Media dialog box restricts you from specifying settings that conflict with 
any media, page size, or finishing settings that have been specified for the job in the 
Job Properties dialog box or printer driver. 

• When two or more Mixed Media settings are in conflict with each other, the Mixed Media 
dialog box highlights the setting names in red, signaling you to resolve the conflict.

• When you specify print options (in the Job Properties dialog box or printer driver) after 
specifying Mixed Media settings, certain print options may conflict with the page-specific 
Mixed Media settings. You must resolve the conflict by choosing different print options or 
removing certain Mixed Media specifications.

• Mixed Media settings affect the use of output color profiles when the “Use media defined 
profile” option is selected in Color Setup. For more information, see Color Printing.

• If counters are configured for the digital press, blank media inserted between pages count 
as printed pages.

Basic instructions for accessing and using Mixed Media are provided in Command 
WorkStation Help. Features specific to the EX700i are described in the following procedures.
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TO DEFINE MIXED MEDIA SPECIFICATIONS

1 Select or right-click a spooled/held job in the Job Center view and choose Properties from the 
Actions menu, or double-click a job.

2 Click the Media icon and scroll down to Mixed Media.

The Mixed Media dialog box lists any previously defined media settings and includes buttons 
for defining, modifying, and removing settings.

3 For Chapter Start Page(s), type the page numbers on which you want to start new chapter 
sections.

Type page numbers as comma-separated values (for example: 4,9,17) to designate the start 
of each new chapter. This feature forces each starting page to use a right-side page, adding 
a preceding left-sided blank, if required. 

NOTE: It is not necessary to type the first page, and page numbers refer to the numbering of 
the original document. If you use the Chapter Start Page(s) feature, all media specified in the 
Paper menu per chapter must share the same dimensions (for example, all Letter, all Tabloid, 
or all A4).
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4 To apply finishing options (for example, stapling or sorting) to each chapter created using 
the Chapter Start feature, select the “Define Each Chapter As A Separate Finishing Set” 
option.

NOTE: Not all finishing options can be applied to chapters that contain mixed sizes of media 
(for example, Letter and A4).

5 To define properties for front and back covers, click Define Cover. 

For more information, see “To define cover media settings” on page 22.

6 To define properties for individual pages or page ranges, click New Page Range.

For more information, see “To define media for specific pages” on page 23.

7 To insert tab media, click New Tab.

The Insert Tab dialog box appears. For information about defining tab settings, see page 25.

NOTE: The Insert Tab feature is not available for imposed jobs.

8 To insert blank pages, click New Insert.

For more information, see “To insert blank pages” on page 24.

9 To modify or delete a current definition, select it in the Mixed Media Definition list, and click 
Edit or Remove.

If you click Edit, enter new settings for the definition and click Modify.

10 After you finish defining Mixed Media settings, click OK to close the Mixed Media dialog box 
and Job Properties.

The Mixed Media settings are applied to the job.

NOTE: You can save up to 100 different settings for the Selection list in the Mixed Media 
dialog box.
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TO DEFINE COVER MEDIA SETTINGS

1 In the Mixed Media dialog box, click Define Cover.

The Cover Media dialog box appears.

2 To define identical front cover and back cover media, select the “Apply the same settings 
for both front and back cover” option. To define media settings for the front or back cover 
individually, select the Front Cover or Back Cover option.

3 Choose other settings, as required, from the pull-down menus.

4 Choose the required media from the Media menu.

To select media from Paper Catalog, select Choose from Paper Catalog from the Media menu.

The media that you selected appears in the Mixed Media area.

For more information about Paper Catalog, see page 36.

5 Click OK to return to the Mixed Media dialog box.

Cover Media settings override settings defined in the Page/Page Range Media dialog box.
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TO DEFINE MEDIA FOR SPECIFIC PAGES

1 In the Mixed Media dialog box, click New Page Range.

The Page/Page Range Media dialog box appears.

2 Type pages and page ranges as comma-separated values (for example: 3,9–14,18).

3 Choose other settings, as required, from the pull-down menus.

If you assign a new media type to the back side of a duplexed sheet, a blank page is inserted to 
force the assigned page content to the front side of the next sheet.

4 Choose the required media from the Media menu.

To select media from Paper Catalog, select Choose from Paper Catalog from the Media menu.

The media that you selected appears in the Mixed Media area.

For more information about Paper Catalog, see page 36.

5 Click Add Definition after each media setting that you define. 

6 Click Close to return to the Mixed Media dialog box.
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TO INSERT BLANK PAGES

1 Click New Insert in the Mixed Media dialog box.

The Insert Blank dialog box appears.

2 Indicate whether to insert the blank before or after the target page. Define the target 
page as the first or last page in the document, or as a specific numbered page.

3 Choose other settings, as required, from the pull-down menus.

4 Choose the required media from the Media menu.

To select media from Paper Catalog, select Choose from Paper Catalog from the Media menu.

The media that you selected appears in the Mixed Media area.

For more information about Paper Catalog, see page 36.

5 Click Insert after each blank page that you define.

6 Click Close to return to the Mixed Media dialog box.
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Insert Tabs

The Insert Tabs feature allows you to automatically insert tab pages throughout a job. This 
feature accommodates various sizes and types of tab media stock. You can insert the tab text 
and override text attributes on a per-job basis.

NOTE: When you configure counters for the digital press, printed tab pages count as black-
and-white pages, provided colors are calibrated to use pure black toner. Expelled tabs are not 
counted as printed pages.

TO INSERT TAB PAGES

1 Select or right-click a spooled/held job in the Job Center view and choose Properties from 
the Actions menu, or double-click a job.

2 Click the Media icon and scroll down to Mixed Media.

3 Click New Tab in the Mixed Media dialog box.

The Insert Tab dialog box appears. 

4 Type the number of tab positions included in a complete tab set in the “Number of tabs 
in a set” field.

This specification ensures that tab text is printed in the correct tab positions. For example, 
tab positions in a set consisting of 10 tabs are distinct from tab positions in a set consisting of 
five tabs. 

5 Specify other settings, as required, for the tab stock.



COMMAND WORKSTATION 26

6 Choose the required media from the Paper Catalog menu. 

You can also click the Select button to open the Paper Catalog window, select the required 
media, and then click OK.

The media that you selected appears in the Mixed Media area.

For more information about Paper Catalog, see page 36.

7 To specify attributes for the tab text, type the number of tabs in the “Number of tabs to 
insert” field, and then click Insert.

Use the following procedure to define the tab text.



COMMAND WORKSTATION 27

TO SPECIFY TAB TEXT

1 Select the “Apply the same text attributes for all tabs” option in the Tabs Text dialog box if 
you want all the tabs to use the same text attributes. 

2 Click Insert.

3 In the Text Attributes column, click the arrows to display the menus for font, size, text 
rotation, and text alignment, and choose the attributes that you want from each menu.

4 Indicate where you want each tab inserted in the document.

• In the Page field, type the page number where you want the tab inserted.

• Select Before to insert the tab before the page number, or clear this check box.

NOTE: If you define a tab to be inserted between an odd-numbered page and an even-
numbered page in a duplex job, the tab is inserted after the odd-numbered page on the first 
sheet, and the even-numbered page is printed on the next sheet.

5 Type the desired tab text for each tab in the Tab Text field.

To define text attributes for each tab individually, click Text Attributes for that tab.

6 After you type the tab text, click OK to close the Insert Tab dialog box.

The Mixed Media dialog box displays the current tab settings in the Mixed Media 
Definition list.

7 To modify media settings for the tabs, select the tab description in the Mixed Media 
Definition list, and then click Edit.

8 To apply your Insert Tab settings to the document, click OK to close the Mixed Media dialog 
box and Job Properties.
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Output tray for unused tabs 

Unused tabs can be sent to a specific output tray. For example, if you print a three-tab job and 
are using tab paper that has five tabs in a set, the fourth and fifth tabs are unused. To select 
the output tray for unused tabs, click New Tab in the Mixed Media window, select Output 
Tray to Kick Out Unused Tabs, and then choose the output tray from the drop-down menu.

From Insert Tab, specify:

• Number of tabs in the set of tab paper that you are using

• Tab positions 

• Page number of tabs

NOTE: Output Tray to Kick Out Unused Tabs is only available when you print multiple 
copies of a tab job. You cannot specify a finisher for the unused tab paper output tray if that 
finisher is not used for your job. 

ImageViewer
If Fiery Graphic Arts Package, Premium Edition is installed and enabled on the EX700i, you 
can use ImageViewer to preview and adjust colors on a job that has been processed and held. 
For information about using ImageViewer, see Fiery Graphic Arts Package.

NOTE: When available, ImageViewer replaces the standard full-screen preview window 
described in Command WorkStation Help.
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Troubleshooting
When troubleshooting basic connection and software problems with Command 
WorkStation, see the following sections. For additional troubleshooting information, 
see Command WorkStation Help.

Command WorkStation cannot connect to the EX700i

If you cannot connect to the EX700i or locate the EX700i from your computer, contact the 
network administrator. The administrator may need to troubleshoot your network 
connections and check settings on the servers that you print to. If settings have changed, it 
may be necessary to reconfigure the EX700i (see Configuration and Setup).

If you can connect to the EX700i with another utility, you may need to reconfigure the 
Command WorkStation connection to the EX700i (see page 16).

If you configured the EX700i and set up client computers and network servers according to 
the instructions in Configuration and Setup, print a Test Page. If you can print the Test Page 
but still cannot print a document from a remote computer, contact your network 
administrator to troubleshoot the network connection.

If you cannot connect and cannot print a Test Page, check the digital press touch panel for 
error information.

Command WorkStation does not respond

If Command WorkStation is unresponsive, use the following troubleshooting guidelines.

IF THE COMMAND WORKSTATION WINDOWS DO NOT UPDATE

1 Log off and then quit Command WorkStation. 

2 Restart Command WorkStation or restart the computer. 

If the Command WorkStation windows do not update or no jobs are displayed, and the 
mouse has no effect (you cannot select a job or a window, use a right mouse command, or 
select a menu item), the EX700i is offline or network communication has failed.

TO FORCE AN EXIT FROM COMMAND WORKSTATION

1 Windows: Press Ctrl-Alt-Delete and use the Task Manager to close Command WorkStation. 

Mac OS X: Choose Apple menu > Force Quit, select Command WorkStation, and then click 
Force Quit. Or, press Command+Option+Esc, select Command WorkStation, and then click 
Force Quit.

2 At the EX700i, disconnect and reconnect the network cable, and then try printing a Test Page 
or Configuration page.

3 If printing fails, restart the EX700i.
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FIERY SEEQUENCE SUITE

Fiery SeeQuence Suite is an integrated job preparation tool that offers the following modes, 
depending on what (if any) client dongle is available:

• Fiery SeeQuence Preview provides a preRIP job preview.

• Fiery SeeQuence Compose allows you to define the chapter divisions of a job, print ranges 
of pages on varying types of media, insert blank media between pages, and insert tab media 
containing text labels (if the digital press supports tab printing). 

• Fiery SeeQuence Impose applies imposition layouts to jobs for custom printing, binding, 
and trimming. Impose also applies impositions to variable data jobs and saves imposed 
jobs as PDF files.

• Fiery SeeQuence Suite integrates Impose and Compose features in the Preview window.

NOTE: Fiery SeeQuence Compose is available as an option for EX700i Print Server.

NOTE: Fiery SeeQuence Suite is available as an option for Integrated Fiery Color Server.

This chapter uses the term “Compose” to refer to Fiery SeeQuence Compose, “Impose” to 
refer to Fiery SeeQuence Impose, and “SeeQuence Suite” to refer to Fiery SeeQuence Suite.

About SeeQuence Suite kits
SeeQuence Suite software is available in the following kit configurations:

• Impose kit (includes the Adobe Acrobat/Enfocus PitStop DVD and a dongle): standard 
for EX700i Print Server

• Compose kit (includes the Adobe Acrobat/Enfocus PitStop DVD and a dongle): optional 
for EX700i Print Server

• SeeQuence Suite kit, which includes Impose and Compose (includes the Adobe Acrobat/
Enfocus PitStop DVD and a single dongle); optional for Integrated Fiery Color Server

Impose and Compose are supported on Windows and Mac OS computers. For information 
about system requirements, see Welcome.

NOTE: You must have the software kit-specific dongle installed on your computer to use the 
full functionality of the software. If you do not have the dongle installed, Impose runs in 
Demo mode. In Demo mode, imposed jobs print with a watermark, and you can save 
imposed jobs in .dbp format to the EX700i. You can save imposed jobs in Adobe PDF format 
to a hard drive and the EX700i when you are in Demo mode, but they are saved with a 
watermark. 
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Installing and enabling SeeQuence Suite
The following sections describe how to install and enable SeeQuence Suite.

Installing SeeQuence Suite software

SeeQuence Suite software is installed with Command WorkStation software. For information 
on installing Command WorkStation software, see pages 9 and 16.

Enabling SeeQuence Suite software

Impose and Compose are dongle-protected features of Command WorkStation that work in 
conjunction with Adobe Acrobat and the Enfocus PitStop plug-in. You must install a special 
dongle on each computer that runs the SeeQuence Suite software. This section explains how 
to install the dongle and the required software. 

You will need the following items:

• Dongle: A USB dongle included in one of the following kits:

– Impose

– Compose

– SeeQuence Suite, which includes Impose and Compose (a single dongle) 

NOTE: If you purchased an earlier version of Impose or Compose, you can use the dongles you 
already own to enable Impose or Compose.

• Adobe Acrobat/Enfocus PitStop DVD: Included in the SeeQuence Suite kits. Contains 
installers for Adobe Acrobat and Enfocus PitStop, a plug-in module for Acrobat, for both 
Windows and Mac OS X. 

NOTE: Acrobat must be installed on the same computer as the SeeQuence Suite software to 
preview .ps files. You do not need Acrobat or PitStop to preview .pdf files.

If it is not already installed, you will need to install Command WorkStation (see page 16). 
Installing Command WorkStation installs the core SeeQuence Suite software.
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To enable SeeQuence Suite software on a computer (or the EX700i, if it supports, and 
is equipped with, a monitor, keyboard, and mouse), do the following:

• Install the dongle provided in your kit directly on the computer. One dongle is required 
for each client computer.

• Install Acrobat and PitStop from the Installer DVD (Windows or Mac OS) provided in 
this kit.

NOTE: If you are enabling SeeQuence Suite software on the EX700i, the following procedures 
assume that you have logged on to the EX700i with Administrator privileges and typed the 
appropriate password. To ensure network security, the system administrator may change this 
password frequently. Ask your administrator for the password.

TO INSTALL THE DONGLE

1 If Command WorkStation is installed and running on the client computer, exit Command 
WorkStation.

NOTE: If Command WorkStation is running, the dongle installation (described in step 2) will 
fail.

2 Unpack the dongle and install it directly into the computer’s USB connector.

Insert the dongle into the USB connector of the computer. Make sure that the dongle is 
securely installed in the connector.

Install Acrobat and PitStop, as described in the following procedure.



FIERY SEEQUENCE SUITE 33

TO INSTALL ACROBAT AND PITSTOP

1 If the latest versions of Adobe Acrobat and Enfocus PitStop are not installed, uninstall the 
versions of Adobe Acrobat and Enfocus PitStop that are currently resident on the computer.

• Close all open applications.

• Follow the instructions for your computer for removing programs.

• After you finish uninstalling earlier versions of Acrobat and PitStop, restart the computer. 

2 Close all software applications that are currently running on the computer.

3 Insert the Adobe Acrobat/Enfocus PitStop DVD (Windows or Mac OS) into the DVD drive.

4 If the Installer does not start automatically, navigate to the root level of the DVD and 
double-click Setup.exe (Windows) or Setup.app (Mac OS).

5 On Mac OS X, click Install and follow the on-screen instructions. 

On Windows, select the language and click Next.

The SeeQuence Suite software option that you purchased is now fully enabled.

About Help
SeeQuence Suite Help is part of Command WorkStation Help. For instructions on using 
Impose and Compose, see Command WorkStation Help.

The Help menu offers access to the following kinds of Help:

• Online Help provides procedural information.

• How To accesses the EFI web page, which provides demo scripts and sample files.

• What’s New describes the new features of Command WorkStation.

TO ACCESS COMMAND WORKSTATION HELP

1 Start Command WorkStation.

Select the EX700i from the Server list and log on to the server (see “Configuring the 
connection to the EX700i” on page 16).

2 Choose Help, How To, or What’s New from the Help menu.

Or press F1 when the cursor is in an area of the main Command WorkStation window.
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Additional features

For information about any features not described in Command WorkStation Help or 
described incorrectly, see the following sections.

List View

The Help for SeeQuence Preview refers to List View, an alternative way of viewing pages in 
the Page View pane as a list in text format. List View is no longer available. Pages are displayed 
as thumbnails in the Page View pane. 

Using gangup styles with gangup methods for VDP jobs in Impose

In the SeeQuence Suite section of Command WorkStation Help, the table showing gangup 
styles with gangup methods for VDP jobs is incorrect. Use the following table as a reference 
for the styles that can be used with gangup methods for VDP jobs.  

Standard style is the only layout style supported for VDP gangup repeat jobs. All layout styles 
are supported for non-VDP jobs in PostScript or PDF format submitted to Command 
WorkStation through the Import function or printer driver. For jobs submitted through Hot 
Folders, Impose cannot distinguish between VDP and non-VDP jobs, so Standard is the only 
gangup repeat style supported for VDP and non-VDP jobs.

Gangup 
methods

Standard 
style

Head to Head 
style

Foot to Foot 
style

Reversal 
style

Reversal 
alternate style

Repeat Yes No No No No

Unique Yes Yes Yes Yes Yes

Unique-Collate 
Cut

Yes Yes Yes Yes Yes

Multi-Record 
Collate

Yes Yes Yes Yes Yes

Cut and Stack Yes Yes Yes Yes Yes

Duplo - Short
Edge Feed

Yes No No No No

Duplo - Long 
Edge Feed

Yes No No No No
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APPE jobs in SeeQuence Impose

When you impose a job in SeeQuence Impose with APPE (Adobe PDF Print Engine) 
selected in Job Properties, and then save the job, you cannot make any further imposition 
changes to the imposed job. The default for saving APPE imposed jobs is as a flattened PDF, 
which does not allow further changes. 

If you are not satisfied with your imposition choices, start over with the original job. 

NOTE: If you save a job in .dbp format, you can make further imposition changes, but the job 
is RIPped as a PostScript job, not as an APPE job.
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PAPER CATALOG

Paper Catalog is a system-based paper warehouse database that stores attributes of any media 
available for printing from the EX700i. Paper Catalog allows you to define custom catalog 
entries based on any combination of attributes required. You can customize any of the media 
attributes that are available for a catalog entry. You can then select media for your job from 
those listed in the Paper Catalog interface. 

Installing Paper Catalog
Paper Catalog is installed by default with Command WorkStation. 

For information about installing Command WorkStation, see page 16. For information 
about configuring Command WorkStation, see “Configuring the connection to the EX700i” 
on page 16.

For instructions on how to use the standard Paper Catalog features, see Command 
WorkStation Help. For instructions on how to access Command WorkStation Help, see 
page 18.

Specifying Paper Catalog media for jobs
This section describes how to specify Paper Catalog media for use with a print job. You can 
specify Paper Catalog media from the following interfaces:

• Command WorkStation

• Job Properties in Command WorkStation

• Mixed Media Setup in Command WorkStation

• Hot Folders

• SeeQuence Impose

• SeeQuence Compose

• Printer driver (for instructions, see Printing)

NOTE: The following procedures assume that one or more Paper Catalog entries have already 
been defined by an administrator. For information about how to define Paper Catalog entries, 
see the Paper Catalog section of Command WorkStation Help.
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TO ACCESS PAPER CATALOG FROM COMMAND WORKSTATION

• To open Paper Catalog from Command WorkStation, choose Paper Catalog from the Server 
menu, click the Paper Catalog icon on the toolbar, or choose Device Center > Resources > 
Paper Catalog.

TO SPECIFY PAPER CATALOG MEDIA FROM JOB PROPERTIES

1 Select or right-click a spooled/held job in the Job Center and choose Properties from the 
Actions menu, or double-click a job. 

2 Click the Media icon in the Job Properties dialog box.

3 Choose the required media from the Paper Catalog menu, or click Select to open the Paper 
Catalog window. 

NOTE: If you specify a Paper Catalog entry and then use Job Properties to change the page size 
(or another attribute associated with the Paper Catalog entry), the Paper Catalog assignment 
is canceled. Job Properties subsequently displays “none defined” for Paper Catalog. 

TO SPECIFY PAPER CATALOG MEDIA FROM MIXED MEDIA SETUP

1 Select or right-click a spooled/held job in the Job Center and choose Properties from the 
Actions menu, or double-click a job.

2 Click the Media icon in Job Properties and scroll down to Mixed Media.

3 Choose Paper Catalog from the Media menu in the Cover Media, Page Range, or Insert Blank 
windows, and choose the required media from the Paper Catalog menu.

If Insert Tab is supported, choose from the Paper Catalog menu in the Insert Tab dialog box.

For more information about Mixed Media Setup, see the Mixed Media section of Command 
WorkStation Help. 

TO SPECIFY PAPER CATALOG MEDIA FROM SEEQUENCE COMPOSE

1 Select or right-click a spooled/held job in the Job Center and choose Compose from the 
Actions menu. 

2 Select a page, or pages, in the Page View pane of the Compose window, and choose Assign 
Media from the Actions menu. 

3 Choose Paper Catalog from the Media menu and select the required media.

For information about using Compose, see the Compose section of Command WorkStation 
Help. Compose Help also includes information about how to apply Paper Catalog entries to 
your job.
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TO SPECIFY PAPER CATALOG MEDIA FROM SEEQUENCE IMPOSE

1 Select or right-click a spooled/held job in the Job Center and choose Impose from the Actions 
menu. 

2 Click Edit beside the Sheet menu. 

3 Choose Paper Catalog from the Media menu and select the required media.

For information about using Impose, see the Impose section of Command WorkStation 
Help. Impose Help also includes information about how to apply Paper Catalog entries to 
your job.

TO SPECIFY PAPER CATALOG MEDIA FROM HOT FOLDERS

1 In the Hot Folder Settings dialog box, select Define from the Job Properties drop-down menu.

2 Click the Media icon in the Job Properties dialog box.

3 Choose the required media from the Paper Catalog menu. 

4 Click OK to return to the Hot Folders Settings dialog box.
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PRODUCTIVITY PACKAGE

The Productivity Package (optional for the Integrated Fiery Color Server) offers additional 
color and production features for Integrated Fiery Color Server operators (or users with 
Operator or Administrator privileges) to monitor and manage the print workflow of jobs on 
the Integrated Fiery Color Server. The Productivity Package is installed with Command 
WorkStation software, and all the features are accessible from Command WorkStation. For 
information about installing Integrated Fiery Color Server user software, see page 9.

NOTE: These features are standard for the EX700i Print Server.

For information about using Command WorkStation, see page 14 and Command 
WorkStation Help.

Color features

The color features available with the Productivity Package are the following:

• Spot-On, with Substitute Colors and Composite Overprint

• Configurable Auto-trapping (with Rich Black Auto Trapping)

• Image Enhance (Interactive)

• ImageViewer 

• Paper Simulation (with Paper Simulation editing)

• Control Bar (with the Ugra/FOGRA Media Wedge color bar)

• PostFlight

For information about these color features, see Color Printing. 

Production features

The production features available with the Productivity Package are the following:

• Filters for Hot Folders (see Hot Folders Help)

• Advanced Job Management 

– Process Next (see page 40)

– Schedule Print (see page 40)
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Using the production features
The following sections describe how to access and use some of the production features of the 
Productivity Package.

Process Next

The Process Next feature moves the selected job immediately to the processing queue. If 
another job is currently processing, the selected job for Process Next is processed immediately 
after. The feature is on the Actions menu in Command WorkStation and is described in 
Command WorkStation Help.

Schedule Printing

The Schedule Printing feature allows you to set a specific date and time for printing a job. 
This feature is accessible from Command WorkStation. 

Assign Schedule Printing settings to a job from the following areas:

• Printer driver on a Windows computer only (see Printing)

• Job Properties window in Command WorkStation

The following procedures describe accessing Schedule Printing from Command 
WorkStation. 

TO SCHEDULE A JOB FOR PRINTING FROM THE JOB PROPERTIES WINDOW

1 Select a job in the Held list and choose Properties from the Actions menu.

2 Click the Job Info icon and scroll down to Destination.

3 Select Schedule Printing, specify the date and time when you want the job printed, and then 
click OK.

NOTE: Display the scheduled date and time by adding a Schedule Printing information 
column to the Held list. For information about adding information columns, see Command 
WorkStation Help.
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SCAN

Scan is a collection of software components that allow you to scan documents from the digital 
press glass or through the digital press automatic document feeder (ADF) and send the 
scanned images to specific destinations. Scan consists of the following components:

• Remote Scan includes the TWAIN plug-in module. Remote Scan allows you to remotely 
retrieve a scan from a digital press.

• Scan to E-mail allows you to send the scan file by e-mail as an attachment or URL.

• Scan to FTP allows you to send the scan file to an FTP server.

• Scan to Internet Fax allows you to send the scan file to an e-mail address, to be delivered as 
a fax.

• Scan to Mailbox allows you to send the scan to a mailbox on the EX700i, from where it can 
be retrieved.

• Scan to Hold queue allows you to scan to the EX700i Hold queue for document merging 
and editing.

• Docs WebTool allows you to retrieve scanned jobs from mailboxes on the EX700i.
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Installing and configuring Remote Scan
The following sections describe how to install and configure Remote Scan. After you have 
connected to the EX700i, you can access Help from Remote Scan.

Installing Remote Scan

To install and use the Remote Scan application and TWAIN plug-in module, you must have 
a Windows or Mac OS computer with a network connection. For detailed system 
requirements, see Welcome.

The Remote Scan Installer is located on the User Software DVD.

To install Remote Scan, see page 10 and page 12.

Configuring Remote Scan

The first time you start Remote Scan, you must configure the connection to the EX700i. 
Before you configure the connection, you must have the correct IP address. Make sure that 
the EX700i is registered in a Domain Name Server (DNS) on your network. When you open 
Remote Scan, the Scan Configuration dialog box appears. For instructions on configuring the 
connection to the EX700i for the first time, see “To configure the connection to the EX700i” 
on page 43.

Complete instructions on configuring and modifying the connection to the EX700i are 
provided in Remote Scan Help.

If you previously configured a connection to the EX700i, it appears in the main Remote Scan 
window. You can immediately initiate a scan, retrieve scans initiated at the digital press touch 
panel, and use Remote Scan Help.
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TO CONFIGURE THE CONNECTION TO THE EX700I

1 When you start Remote Scan for first-time use, the Configuration window automatically 
appears. Type the IP address or DNS name of the Print Server in the Server Name (or IP 
Address) text field.

2 Select Use Nickname to enter another name to distinguish the EX700i. This name does not 
have to match the actual Server Name of the EX700i.

3 Type the name of the device connected to the EX700i. 

You can assign any name for the device name.

4 Click the green arrow to add the EX700i to My Fiery List. 

5 Click OK.

TO ACCESS REMOTE SCAN HELP

1 Start Remote Scan or open the Remote Scan plug-in module.

2 Connect to the EX700i that has already been configured.

3 Click Help.

4 Use the Contents, Index, or Search panes to navigate to the Remote Scan Help topics.

Using Remote Scan
With Fiery Remote Scan and the TWAIN plug-in module, you can retrieve scan files 
remotely by accessing a mailbox that is set up in the Users and Groups section of WebTools 
Configure. You can open the scan file in a host application, such as Adobe Photoshop, and 
send the scan file to a mailbox, the Hold queue, or an e-mail address. All scans are stored on 
the EX700i hard disk and retrieved through the network.

For complete instructions on using Remote Scan and the TWAIN plug-in module, see 
Remote Scan Help. 

NOTE: To quit Remote Scan on a Mac OS X computer, click Close. You cannot quit the 
application from the main menu or by pressing Command+Q.

Initiating scans

Although Help includes instructions for initiating scans from Remote Scan, this feature is not 
supported for the EX700i. Scanning is initiated at the digital press touch panel. For more 
information, see the following section.
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Scanning from the digital press
Scan jobs are initiated at the digital press touch panel and stored in a mailbox on the EX700i 
for remote retrieval or sent from the EX700i using e-mail, Internet Fax, FTP, or SMB. You 
can retrieve scan jobs from a mailbox with WebTools Docs or the Remote Scan application.

The EX700i uses Scan Settings, or scan templates, to determine how to scan a document and 
where to send it. Each scan template is listed in the Network Scanning area of the digital press 
touch panel. To scan a document, you must use one of these scan templates. A number of 
default scan templates are provided with the EX700i. You can modify a duplicated scan 
template at the digital press touch panel, or create a new scan template with WebTools Scan 
Settings.

Scanning workflows

Any user can initiate a scan at the digital press by selecting one of the default scan templates 
listed in the Network Scanning area of the digital press touch panel. The scan can then be 
retrieved from the “guest” mailbox with WebTools Docs or Remote Scan.. For more 
information, see “Default scan settings” on page 45.

You can specify a different destination for a default, editable scan template on the Scan tab of 
the Web Applications area of the digital press touch panel, and save it as a new scan template. 
You can then select the new scan template from the list in the Network Scanning area of the 
digital press touch panel. For more information, see “Modifying scan settings at the digital 
press” on page 47.

With WebTools Scan Settings, the EX700i administrator can create a custom scan template 
that other users cannot edit. The administrator can assign ownership of this new scan 
template to an existing user. The administrator or the user who owns the template can define 
the document settings and destinations for the template. It then appears in the list in the 
Network Scanning area of the digital press touch panel. 

The administrator sets up mailboxes for scan jobs in WebTools Configure Users and Groups. 
The administrator belongs to the “admin” group. The “guest” and “operator” groups are also 
default groups on the EX700i. A mailbox is set up by adding user names to a group with Fiery 
Mailbox Privileges. The administrator can also add users from an LDAP address book. 
Administrators can view and manage all Scan Settings templates, including deleting 
templates, and changing the user name/mailbox for a specific Scan Settings template. 
Administrators can also view all mailboxes in WebTools Docs and manage the scans sent to 
mailboxes.

NOTE: To log on to WebTools Docs and Scan Settings as administrator, you must type the 
user name admin.
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Default scan settings

To initiate a scan from the digital press touch panel, you must choose a scan template. The 
EX700i comes with several default scan settings templates that you can select at the digital 
press touch panel. 

Default, locked templates that cannot be changed are:

• 001 Fiery_BW: for black-and-white documents

• 002 Fiery_Color: for color documents

• 003 Fiery_ColorCal: for calibrating the EX700i

• 004 Fiery_Grayscale: for grayscale documents, such as black-and-white photographs

You can create a new template based on one of the default guest templates by renaming it and 
modifying it at the digital press or with WebTools Scan Settings. You can also change the 
destination of a scan template at the digital press or with WebTools Scan Settings. You can 
modify document settings with WebTools Scan Settings. 

NOTE: You cannot change the Color mode setting when you create a scan template based on 
one of the EX700i default guest templates or a template you created with WebTools Scan 
Settings.

For information about setting up scan templates, see “Scan Settings” on page 55.

For information about setting up users and mailboxes, see WebTools Configure Help.
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Scanning with default scan settings

When you initiate a scan from the digital press, you select a scan template from the list 
displayed on the digital press touch panel. 

NOTE: The following procedure assumes that the digital press is in Copy mode when you start 
to scan a document.

TO SCAN A DOCUMENT FROM THE DIGITAL PRESS

1 Press the All Services icon on the digital press touch panel.

2 Press Network Scanning.

All Scan Settings templates are displayed.

3 Select the template that you want to use. 

4 Select options on the Network Scanning, Advanced Settings, Layout Adjustment, and Filing 
Options panes, as needed.

NOTE: You cannot change the Color mode setting for any of the default templates or 
templates created from them.

After you select options on the Advanced Settings, Layout Adjustment, and Filing Options 
panes, you must click Save. Any document settings selected at the digital press touch panel 
before scanning a document are only saved and applied for the scan that you are performing. 
After the scan is completed, the settings revert to the original settings for that scan template.

5 Press the green Start button on the front of the digital press.

6 Retrieve your scan with Remote Scan or WebTools Docs.

NOTE: The default mailbox for all default Scan Settings is guest.

For more information about document settings on the digital press, see the documentation 
that accompanies your digital press.



SCAN 47

Modifying scan settings at the digital press

All users can modify guest-owned scan settings at the digital press. When you choose a scan 
template in the Web Applications area of the digital press touch panel, you can rename the 
template to create a new template, and then edit the scan template destinations.

When you use a default template as the basis for a new template, you cannot change the Color 
mode of the original template. So when you select a template to use as the basis for a new 
template, consider Color mode: color, black-and-white, or grayscale.

TO MODIFY A SCAN TEMPLATE ON THE DIGITAL PRESS TOUCH PANEL

1 Press All Services on the digital press touch panel.

2 Press Web Applications.

3 Press the Scan tab.

NOTE: Only the guest-owned scan templates are displayed. “Guest-owned” means that they 
were created under the user name “guest,” and that the scans are sent to the guest mailbox.

4 To change the destination mailbox for a guest-owned scan template, you must log on with 
Administrator privileges. 

To do so, click Login, select Administrator, and type the Administrator password.

Press Enter, and then press Login again.

5 To view the destination settings for a scan template, press the two arrows to the left of the 
scan template name. 

The scan destinations designated for that template are displayed.

6 To view the document settings for the template, press Next at the upper-right of the window.

The Document Settings are displayed.

7 Press OK to return to the Scan Templates page.

8 To create a scan template, press Edit for the template that you want to use as the basis.

9 Type a new name in the Name field for the Scan Settings and press Enter.

The user name for all scan templates displayed in Web Applications on the digital press touch 
panel is guest and cannot be changed by users with guest access. If you log on with 
Administrator privileges, you can change the user name. As the administrator, you can also 
change the user name with WebTools Scan Settings.

NOTE: The new scan template name must consist of uppercase letters and numbers; lowercase 
letters and special characters are not allowed.

10 If desired, type a description in the Description field and press Enter.

11 Press Next.
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12 Select one of the following destinations:

• Fiery Mailbox allows you to send a scan file to a mailbox that you select in WebTools Scan 
Settings. You must set up the mailbox first as a user of a group in WebTools Configure 
Users and Groups with mailbox privileges. The default mailboxes are: admin, operator, 
and guest.

• E-mail allows you to send a scan file via e-mail. In Setup, the administrator determines the 
maximum allowed size of the attachment. If the attachment exceeds this maximum size, 
the EX700i sends the scan as a URL. For more information, see Configuration and Setup.

• Network Shared Folder allows you to send a scan file to any network folder or computer on 
the network using SMB. You must know the domain, the computer name (server name), 
and the shared folder for the destination computer to send a file using SMB. You are 
required to type a user name and password. If a password is required, but not entered, no 
error message is displayed, and the scan file is not sent to the destination. It may be that a 
password was not required. Ask your network administrator for the login requirements for 
any SMB connection on your network. 

• FTP allows you to send a scan file to an FTP site. If a Proxy Server was enabled by the 
administrator in Setup, ask the administrator for the Proxy Address. You may be required 
to type a user name and password. If the user name is displayed as blank, an anonymous 
logon is allowed, and you do not have to type a password.

13 Press Next. 

14 Specify Document Settings for the scan and press Next.

15 Specify Scan Size settings and press Next.

16 Specify Scan Enhancements and press Done.

The new scan template that you created appears in the list of templates.

17 Press All Services on the digital press touch panel.

18 Press Network Scanning, and then press Update Templates.

After you create your new template, you can specify document settings on the digital press 
touch panel and initiate a scan.

Retrieving scans

You can retrieve scans from a mailbox with WebTools Docs or Remote Scan. For information 
about Remote Scan, see “Using Remote Scan” on page 43. For information about WebTools, 
see page 52.
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FIERY BRIDGE

Fiery Bridge is an application that allows you to access scanned documents in your EX700i 
mailbox directly from a client Windows computer.

Fiery Bridge makes your mailbox accessible as if it were a standard network drive, allowing 
you to browse its contents using Windows. You can open a scanned document from an 
appropriate application on your computer, just as you would open any other file.

Fiery Bridge is an alternative to transferring scanned documents from a EX700i with Remote 
Scan or WebTools, and can simplify your scanning workflow. You can use Fiery Bridge in 
combination with Hot Folders to create an automated workflow. 

Installing Fiery Bridge
Install Fiery Bridge on a Windows computer with a network connection to the EX700i. 

The Fiery Bridge Installer is provided on the User Software DVD. Before you install the 
utility, read “Preparing for installation on a Windows computer” on page 9.

To install Fiery Bridge, see “Installing user software on a Windows computer” on page 10.

Using Fiery Bridge

TO START FIERY BRIDGE

• Click Start and choose All Programs > Fiery > Fiery Bridge, or double-click the Fiery Bridge 
shortcut on your desktop.

For complete instructions on how to use the standard Fiery Bridge features, see Fiery Bridge 
Help.

TO ACCESS FIERY BRIDGE HELP

1 Start Fiery Bridge.

2 Choose Help > Help.
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HOT FOLDERS

Hot Folders provide a simple and automated method of sending print jobs to the EX700i 
across the network. The user drops documents into a folder that stores and reuses preset print 
options for printing PostScript and PDF files on the EX700i. 

With Hot Folders, you can do the following:

• Create special folders (hot folders) that assign specific print settings and print queues to 
jobs.

• Print jobs to the EX700i by dragging and dropping them onto hot folders on your 
computer’s desktop.

• Monitor the status of jobs sent to hot folders.

Installing Hot Folders
The Hot Folders Installer is on the User Software DVD.

Before installing the utility, make sure that you complete the preliminary procedures 
described on page 9.

Upgrading from an earlier version of Hot Folders

Hot Folders includes a Migration Assistant that detects an earlier version of Hot Folders and 
upgrades any existing Hot Folders settings to work in the latest version. The migration takes 
place only once during the installation of Hot Folders or Command WorkStation. The 
summary in the Migration Assistant window indicates whether or not a Hot Folder 
transferred successfully to the latest version, and in case of failure, allows you to retry once 
during installation without exiting the Migration Assistant. 
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TO MIGRATE FOLDER SETTINGS FROM AN EARLIER VERSION OF HOT FOLDERS

1 Install Hot Folders and allow the Migration Assistant to detect the earlier version. 

NOTE: The Migration Assistant window only appears if an earlier version of Hot Folders is 
installed. (Earlier versions include the following: on Windows, all 2.x versions; on Mac OS, 
all 1.x versions.)

2 Click OK and follow the on-screen instructions.

NOTE: Do not click Cancel when migration is in progress. Cancelling the operation may cause 
permanent damage to the Hot Folders being upgraded. 

3 Check the summary in the Migration Assistant window.

If migration is successful, the successful icon ( ) is displayed next to each Hot Folder. If 
migration fails, or only partially succeeds, the failed icon ( ) is displayed next to the Hot 
Folders that failed to migrate, with any details highlighted in the lower pane.

4 In case of failure, click Retry to attempt migration again before exiting the Migration 
Assistant.

NOTE: Retrying generates a new summary, checking only the files that failed.

5 Click OK.

Using Hot Folders
For instructions on how to use the standard Hot Folders features, see Hot Folders Help.

TO ACCESS HOT FOLDERS HELP

1 Start Hot Folders.

2 Choose Help > EFI Hot Folders Help.
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WEBTOOLS

WebTools allow you to manage your EX700i remotely from the Internet or your company’s 
intranet. The EX700i has a home page, where you can select the following WebTools:

• Home provides current information about the jobs processing and printing on the EX700i.

• Downloads allows remote users to download installers (for drivers, PPDs, and other 
software) directly from the EX700i.

• Docs allows remote users to access jobs on the EX700i over the Internet or intranet. 

• Scan Settings allows the EX700i administrator to create and modify scan templates.

• Configure allows the EX700i administrator to view and modify Setup options remotely 
from a Windows computer.

Setting up WebTools
WebTools are accessed through the home page of the EX700i web site and do not require 
special installation. However, WebTools do require initial Setup by the EX700i 
administrator.

To enable network users to access and use WebTools, the administrator must set specific 
options in Network Setup and Printer Setup. For information about these specific Setup 
options, see Configuration and Setup.

The administrator must prepare each user computer to communicate with the EX700i over 
the Internet or intranet.
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TO SET UP CLIENT COMPUTERS TO USE WEBTOOLS

1 Enable TCP/IP networking.

2 Make sure that the workstation has a valid, unique IP address.

3 Make sure that a supported Internet browser is installed on the computer.

For more information on supported browsers, see Welcome.

4 Make sure that Java is enabled in your Internet browser.

The Fiery User Software Installer automatically installs Java during installation of the 
software. For information, see page 9.

NOTE: If you start WebTools with Internet Explorer from a Windows 2008 computer and 
Java Runtime Environment (JRE) is not installed, Internet Explorer may appear blank and 
will not prompt you to install JRE. However, WebTools Configure downloads JRE and runs 
as expected on Windows 2008 (32-bit) if the Internet Explorer Enhanced Security 
Configuration is disabled. 

Pop-up Blocker with WebTools

Pop-up Blocker is turned on by default in some versions of Internet Explorer on Windows 
computers. With this function turned on, a warning message appears when you access 
WebTools, and your access to WebTools is denied. To gain access, do one of the following:

• Change the Pop-up Blocker setting by clicking the warning message and choosing from 
one of the selections that appears.

• Turn off Pop-up Blocker in the Internet Explorer Tools menu. 

For more information, see Internet Explorer Help, or the documentation that accompanies 
the Windows operating system.

Accessing the WebTools home page
Use your Internet browser to access WebTools. For complete information about browser and 
system requirements, see Welcome.

1 Start your Internet browser. 

2 Type the IP address or DNS name of the EX700i.

The EX700i home page appears. 

3 Click the tab for the WebTool that you want to use.
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Using WebTools
The following sections describe how to use the WebTools.

Home

Home lets you view processing and printing status on the EX700i. If you wish, you can 
specify how often printing and processing information is updated by selecting a time interval 
from the Refresh Status menu.

For complete instructions on how to use Home, see Help. 

Downloads

The Downloads WebTool allows you to download installers (for drivers, PPDs, and other 
EX700i software) directly from the EX700i.

For complete instructions on how to use Downloads, see Help. 

Docs

Docs allows you to access jobs on the EX700i over the Internet or intranet. You can:

• Manage and distribute jobs in your mailbox, if scanning to mailboxes is supported on your 
digital press. 

Mailboxes are set up with WebTools Configure.

• Control and modify jobs.

• Submit jobs to the EX700i.

NOTE: By default, three levels of users are set up for Docs: admin, operator, and guest. Ask 
your administrator for your level of access and any required password.

For complete instructions on how to use Docs, see Help. 
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Scan Settings

Scan Settings allows the EX700i administrator to set up scan templates. These scan templates 
are accessible from the digital press touch panel, by pressing Network Scanning. The Network 
Scanning digital press touch panel displays the default digital press scan templates, as well as 
any that have been set up through WebTools Scan Settings. 

The EX700i administrator can edit and delete scan templates, duplicate templates, export a 
list of templates with their settings, and import a list of templates with their settings. 

TO CREATE A SCAN TEMPLATE

1 On the WebTools Home page, click the Scan Settings tab.

2 Log on with Administrator privileges. 

Only administrators can create scan templates. You must type admin in the User Name field 
and type the Administrator password.

3 Click the New icon.

4 In the General Settings area, specify the following options for your scan template.

• Template name: Specify the name to display on the digital press touch panel and in the list 
of Scan Settings.

• Description: Type a description of your scan template, to allow users to identify the scan 
template at the digital press touch panel.

• Username: Specify the owner name of the scan template. When you log on to Scan 
Settings, only those scan templates that match your user name are displayed.

This option can only be edited by an administrator. The administrator can specify any 
EX700i user who has mailbox rights (including local EX700i users, LDAP users, and 
members of LDAP groups with mailbox privileges). 

5 Click the Browse button to display the available user names.

6 Select a user and click OK to return to the General Settings area.

7 Click Next to specify scan destinations.

8 In the Scan Destination area, select the destinations that you want and enter the required 
information.

You can send a scan to a Fiery Mailbox, E-Mail, Network Shared Folder, or FTP server.

• Fiery Mailbox allows you to send a scan file to a mailbox that you select in WebTools Scan 
Settings. You must set up the mailbox first as a user of a group in WebTools Configure 
Users and Groups with mailbox privileges. The default mailboxes are: admin, operator, 
and guest.

• E-mail allows you to send a scan file via e-mail. In Setup, the administrator determines the 
maximum allowed size of the attachment. If the attachment exceeds this maximum size, 
the EX700i sends the scan as a URL. For more information, see Configuration and Setup.
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• Network Shared Folder allows you to send a scan file to any network folder or computer on 
the network using SMB. You must know the domain, the computer name (server name), 
and the shared folder for the destination computer to send a file using SMB. You are 
required to type a user name and password. If a password is required, but not entered, no 
error message is displayed, and the scan file is not sent to the destination. It may be that a 
password is not required. Ask your network administrator for the logon requirements for 
any SMB connection on your network. 

• FTP allows you to send a scan file to an FTP site. If a Proxy Server was enabled by the 
administrator in Setup, ask the administrator for the Proxy Address. You may be required 
to type a user name and password. If the user name is displayed as blank, an anonymous 
logon is allowed, and you do not have to type a password.

9 Click Verify Settings to check that the destinations are correctly configured.

10 Click Next to specify settings for Scan Output.

11 In the Document Settings and Scan Enhancements areas, choose settings from the menus for 
each option.

12 Click Done. 

The newly created scan template appears in the Scan Templates list. 

13 To display the new scan templates on the digital press touch panel, click Update Templates in 
the Network Scanning pane. 

Viewing Scan Settings in WebTools

When you log on to Scan Settings, you can view the settings for all scan templates associated 
with your user name. 

TO VIEW SCAN SETTINGS IN WEBTOOLS

1 Start your Internet browser. 

2 Type the IP address or DNS name of the EX700i.

3 Click the Scan Settings tab.

4 Log on to Scan Settings.

To log on as guest, you do not need to type a password. To log on with Administrator 
privileges, you must type admin in the User Name field and type the Administrator password, 
if required.

5 To view the settings for a scan template, click the name of the scan template.



WEBTOOLS 57

Modifying scan templates in WebTools

You must log on with administrator privileges to edit, duplicate, delete, import, and export 
scan templates. 

TO MODIFY SCAN SETTINGS IN WEBTOOLS

1 Start your Internet browser. 

2 Type the IP address or DNS name of the EX700i.

3 Click the Scan Settings tab.

4 Log on to Scan Settings with Administrator privileges.

5 To edit a scan template, select the check box for the template, and then click Edit.

6 Follow the instructions for creating a scan template on page 55.

7 To delete a scan template, select the check box for the template, and then click Delete.

8 To duplicate a scan template, select the check box for the template, and then click Duplicate.

You can then select the duplicate scan template and edit it.

9 To export scan templates, click Export and browse to the location where you want to save the 
file.

The settings for the scan templates are saved as a text file.

10 To import scan templates, click Import and browse to the location of the file that you want to 
import.

Configure

Configure allows the EX700i administrator to view and modify Setup options remotely from 
a Windows computer. For information about using Configure, see Configuration and Setup. 

To use Configure, make sure you complete the procedures described on page 53.

For complete instructions on how to use Configure, see Configure Help. 
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